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Chapter 1 - Introduction to the
program
Introduction to the program
SID calculates hydraulic sections of any form and geometrical and hydraulic characteristics.
The program determines for a given section the height and speed values reached by the water, assuming that
channel has a prismatic form of infinite length.
The formula used by the program is due to Chèzy:

V = χ RJ
where:
V = average speed
R = mean radius of the section, equal to the ratio between the area of the liquid section and the wetted
perimeter
J = loss of load per m of tube or channel
χ = friction coefficient
it is characterised by the following function of χ

χ = 87

R
( R + γ)

where γ = roughness coefficient
The numerical coefficient 87 has the dimension of

g.
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Chapter 2 - System requirements
and program installation
System requirements
•

Pentium® class processor

•

Microsoft® Windows® 95 OSR 2.0, Windows 98, Windows Me, Windows NT®* 4.0 with Service Pack 5 or
6, Windows 2000, or Windows XP

•

64 MB of RAM (128 MB recommended)

•

100 MB of available hard-disk space

•

CD-ROM drive

•

A printer driver must be installed, even if the printer itself is not connected to the PC.

Program Installation
To install SID run the sid32setup.exe installation package from the CD-ROM or from the download directory.

Press the Setup button…
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…and select the directory to create the SID32 folder.
Click the Continue button and the program program is automatically installed.
The first time you run the program the window that allows you to select your preferred language appears.
Simply click on the flag of the language you prefer.

The language selection will be saved in the “LANGUAGE.CFG” file, which is found in the program directory. To
select another language, it is sufficient to exit the program and delete this file. The language selection window is
shown once more at the next run of the program.

4 - SID for Windows – User Guide

Chapter 3 - The program
protection
Hardware protection key
This section should instead be carefully read if the program was bought through the Internet.

Hardware protection key - Parallel port
Plug the hardware protection key that is supplied with the program into the parallel port connector of your PC.
The hardware key should be plugged directly into the PC, before any other device, to avoid hardware conflict
with other keys.
The printer cable can then be connected to the hardware protection key, as it does not interfere with the printing
operation. If the hardware key has not been correctly installed, the program will start in demo mode.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98 and Windows Me
Windows 95, Windows 98 and Windows Me automatically recognize the hardware key, so no other operation is
required.

Windows NT, Windows 2000 and Windows XP
Windows NT, Windows 2000 and Windows XP require the installation of a software driver to enable access to
the hardware key. To install the software driver, follow this procedure:
1. start Windows, and login as Administrator
2. install the package
3. browse the program directory, and run the program SKEYADD.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP
4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator
2. browse the program directory, and run the program SKEYRM.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP
3. restart the computer

Hardware protection key - USB port
Plug the hardware protection key, supplied with the program, into one of the USB connectors of your PC.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP
All Windows versions, except Windows NT, automatically recognize the PnP hardware key, and require the path
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to load the driver from. To install the driver, follow this procedure:
1. start Windows, and login as Administrator (if necessary)
2. install the package
3. browse the program directory, and select the folder HardKeyDrivers\ USB_9x-Me-2000-XP

Windows NT
Windows NT requires the installation of a software driver to enable the access to the hardware key. To install
the software driver, follow this procedure:
1. start Windows, and login as Administrator
2. install the package
3. browse the program directory, and run the program SKEYUSBADD.EXE in the folder
HardKeyDrivers\USB_NT4
4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator
2. browse the program directory, and run the program SKEYUSBRM.EXE in the folder
HardKeyDrivers\USB_NT4
3. restart the computer
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Chapter 4 - Using the program in a
local network
Using the program in a local network
The programs can be used in a local network without moving the hardware key from one computer to another.
It is also possible to purchase multiple licenses to use the program on several computers at once.
The computer to which the hardware key is physically connected is defined as the “Server”, and the computer
that requests the authorisation to run in fully operational mode from to the Server is defined as the “Client”.
The program must be installed on the Server (with the proper hardware key drivers if necessary), and on each
Client (in demo mode).
The program keyserver.exe should also be installed on the Server. The installation file of this program can be
found on the distribution CD-ROM, or on the Internet, at the URL:
http://www.geoandsoft.com/download/KeyServerSetup.exe
Run keyserver.exe and the hardware key management window appears.

Click the “Create Program Configuration File” button, and browse your network to select the executable file you
want to remotely activate (for example \\computer03\c\program files\sid32\sid32.exe). Now, with the
keyserver.exe program running, sid32.exe can also be run from the PC “computer03”.
NOTE: the contemporary use of the program on more then one computer is allowed only if a multiple
license has been purchased.

7 - SID for Windows – User Guide

Chapter 5 - General information
Usage Notations
Some typographical notations and keyboard formats are used in this manual to help locate and interpret
information more easily.
Bold print is used to indicate command names and related options. Characters appearing in bold print should
be typed exactly as printed, including spaces.
Words written in italics indicate a request for information.
CAPITAL letters are used to indicate computer, printer, directory, and file names.
Keyboard formats are used as follows:
•

KEY1+KEY2 - indicates press and hold down key1 and then, at the same time, press key2. For example,
alt+c means one should press and hold the alt key down and, at the same time, press the c key. The keys
are always indicated with capital letters.

•

key1,key2 - A comma (,) between key names means that the keys must be pressed in sequence. For
example, ALT,C means one should press and release the ALT key and then press and release the C key.

Because of the differences in keyboard layouts, the names of the keys on the keyboard may not correspond
with those described in this manual. The word ARROW (LEFT, UP, RIGHT, DOWN) indicates the use of the arrow
keys.
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Chapter 6 - User Interface
User Interface and Data Entering
The user interface is designed to be easy to use and powerful and is supported by complete on-line help. This
help contains practical hints and the theoretical background, where applicable. It should reduce the requirement
of frequently consulting the printed manuals.
All the commands are located inside a menu bar. Each menu contains a list of commands that one can select
with the mouse or the keyboard. The arrangement of the menus, designed with ergonomic criteria, follows the
logical order of the operations, inhibiting the access to further operations until all the necessary data have been
entered.
The interface layout is maintained in all of our programs, to simplify, as much as possible, the transition from
one program to another to avoid having to learn different commands and procedures for similar functions (such
as entering data or managing files).
Let us examine the general components that are available in the user interface of geo&soft programs.

User Interface: Menu Bar and Menus
The Menu Bar manages the access to all the program commands. The goal of the menu design is to offer an
ergonomic, simple, and understandable arrangement of the commands.
The menus used to perform a complete operation are normally ordered left to right and top to bottom. When
possible, the following scheme is used: definition of the name of the project, entering the required data,
performing the calculation, and generating the output as a preview or final print.

The programs automatically disable some menus or commands when the execution of such menus or
commands is not yet feasible. Typical examples are: a calculation menu is disabled when not all the data
needed for the calculation have been completely entered, or a print menu is disabled if not all the calculations
have been executed.
To choose a command from a menu, use the following procedures:


Point the menu that is to be activated, click the left button of the mouse, then point the command to be
activated, and click the left button of the mouse again. If one does not wish to select any command
from the menu that is open, exit the area of the menu before releasing the mouse button.



Press the ALT key to activate the menu bar. Press, on the keyboard, the underlined character in the
menu name or press ENTER or the DOWN arrow, to select the first menu. Press on the keyboard the
underlined character in the menu name or select it using the arrow key and then press ENTER, to
execute a command in the selected menu. Press ESC to close the menus without executing any
command.

The Graphical Output Preview Window
The Toolbar is located in the upper side of the preview window.
The Toolbar allows fast access to the commands with the mouse. Click the corresponding icon, to select one of
the commands that belong to the Toolbar. The Toolbar displays the following commands:
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-



Zoom + : clicking the first icon activates the ZOOM function (it can only be used with the mouse) that
permits the enlargement of part of the drawing. The function remains active until the Zoom - icon is selected.
To enlarge a part of the drawing:
click the icon, and then select the area to be enlarged by clicking the upper-left corner and dragging
the mouse pointer to the lower-right corner. At this point, release the mouse button. Note: due to the
low resolution of the screen, the texts could appear in a slightly different scale at different zoom levels.
This does not affect the quality of the final printouts.

-

Zoom - : click this icon to return to the original scale of the preview.

-

Arrows: click the arrow icons, in "Zoom + " mode, to pan the on-screen preview.

-

Print: click the print icon to send the drawing to the default printer.

-

Resized print: click this icon to send the drawing to the default printer. The image will be resized to fit the
current paper size.

-

DXF: one can export the graphic output as a DXF file by clicking this icon; it gives access to a dialogue
window that enables one to assign a different name to the DXF file, which has, by default, the same name
as the current project.

-

EMF/W: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Microsoft Word. Clicking this icon gives access to a dialogue window that enables
one to assign a different name to the EMF file, which has, by default, the same name as the current project.

-

EMF/D: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Corel Draw. Clicking this icon gives access to a dialogue window that enables one
to assign a different name to the EMF file, which has, by default, the same name as the current project.

-

Exit: click this icon to close the preview window and return to the main menu.

The Input Dialogue Windows
The different menu commands can perform an immediate action, or display a dialogue window in order to input
or edit the various data sets.
When a dialogue window is visible, all the actions that do not pertain to it are ignored. Hence, it is necessary to
close the dialogue window to resume the normal use of the program.

Some fundamental tools are used inside the dialogue windows: data fields such as text and list boxes, and
buttons.
The text boxes are used to input numerical values and text strings. Most of the editing keys (HOME, END, INS,
DEL, etc.) can be used inside these fields. If one sees a small arrow pointing down on the right side of the data
field, one has a list box.
To scroll the list box and select an item, do as follows:


click the arrow, and then click the item to be selected.
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press the DOWN arrow until one arrives at the item to be selected. It is also possible to press a letter to
directly reach the first item that begins with that letter.
Tere are three buttons in the dialogue window:


•

<Ok> - this button saves the entered information and goes on to the next phase.

•

<Cancel> - this button closes the Dialogue window without saving the just entered data, or without
executing the command.

•

<Help> - this opens a window that contains general information on how to use the dialogue windows.

To use the buttons:
click the button



press alt+underlined letter

To edit the data inside the dialogue window, use the following keys:
•

TAB - moves the cursor to the next field; when the cursor is inside the last visible field the cursor goes to the
first control button of the Dialogue window. To return to the previous field, press SHIFT+TAB.

•

ENTER - moves the cursor to the next field. If the cursor is positioned on one of the window buttons, the
corresponding command is executed.

•

BACKSPACE

•

DEL

•

ESC - closes the Dialogue window without saving the entered values or without executing the command. The
<Cancel> button will do the same.

•

UP ARROW/ DOWN ARROW

•

LEFT ARROW/ RIGHT ARROW

•

HOME

•

END

- cancels the last character that has been entered.

- cancels the character to the right of the cursor.

- these are used in multiple fields, or those fields that have a list box.
- moves the cursor to the previous or next field.

-moves the cursor to the beginning of the field.

- moves the cursor to the end of the field.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Data Input With Tables
Tables are used to enter long sequences of numerical values and/or text strings. The keys to be used are the
following:
•

TAB - moves the cursor to the first button in the window. When one presses this key again, the cursor is
moved to the next button.

•

SHIFT+TAB

•

ENTER - moves the cursor into the next input field. If the cursor is positioned on one of the window buttons,
the corresponding command is executed.

•

PAGE UP

•

PAGE DOWN

•

UP ARROW

•

DOWN ARROW -

•

- moves the cursor to the previous button.

- moves the cursor up 15 lines.
- moves the cursor forward 15 lines.

- moves the cursor to the input field directly above.
moves the cursor to the input field directly below.

LEFT ARROW / RIGHT ARROW

- moves the cursor to the field respectively to the left or to the right of the current

position.
•

HOME

•

END

•

F2 - copies the field contents to the extended editing field under the title bar in order to facilitate the editing
of the long strings. When working in this editing field, please REMEMBER to press ENTER, even before
clicking the <Ok> button. Double-clicking a field has the same effect as pressing the F2 key.

- moves the cursor to the beginning of the line.

- moves the cursor to the end of the line.
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The tables have two additional buttons:
•

<Insert> - creates an empty line before the one in which the cursor is positioned.

•

<Delete> - deletes the line in which the cursor is positioned.

IMPORTANT SUGGESTION: you can copy data to or from other programs such as Microsoft Excel:
The data entered in the table can be copied in order to be pasted into another table.
To copy the table’s contents:
press the key combination CTRL+C. The contents will be copied into the Clipboard of Windows.

To paste the Clipboard contents into the table:
press the key combination SHIFT+INS, or CTRL+V.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Message Windows
The function of these windows is to give information to the user concerning the system status, as in the case of
an error due to an improper use of the program.

Help On Line
A complete Help On Line is available. It is possible to ask for information or suggestions related to the
commands or the use of the program. In order to access the help on line, proceed as follows:
1. Position the cursor on a field of a dialogue window and press F1.
2. Use the Summary from the Help menu.
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Chapter 6 - Commands
Files Menu (ALT,F)
This menu contains the commands for opening and saving files. In these all the information relative to the
project is stored. Until a name is given to the work the program will not permit the use of other menus.

New Command (ALT,F,N)
To open a new file:


from the menu choose New by first clicking on the name of the menu then on the New command.



from the File menu choose New by using the combination of the keys ALT,F,N.

Open Command (ALT,F,O)
To be able to work with the program one should, first of all, create a new file or open a pre-existing file.
To open a file:


from the menu choose Open by first clicking on the name of the menu then on the Open command. In
the File Name field type the name of the file to be opened or, if the file already exists, double click on
the name of the desired document which can be found in the list underneath the File Name field.

from the File menu choose Open by using the combination of the keys ALT,F,O. In the File Name cell,
type the name of the file to be opened or, if the file already exists, press TAB and then the UP ARROW or
DOWN ARROW to select the name from the list underneath the File Name field and press ENTER.
The name of the file being used is reported inside the title bar of the main window and inside a window referable
by selecting the Help menu.
The name of the file should not contain spaces and/or punctuation marks. It is not necessary to indicate
extensions, since the extension “.SID” is added automatically: for example, the given name “TEST” will have the
file name “TEST1.SID"


Save Command (ALT,F,S)
During the work session the program uses a copy of the file which is temporarily loaded into the computer’s
RAM. To save work on the hard disk it is necessary to use the Save command; otherwise all the data introduced
will be lost when one exits from the program. If an electrical problem or any other type of problem interrupts the
computer’s functioning all the data not yet saved will be lost, so it is advisable to save the work often.
To save a file:


select Save from the file menu by clicking first on the name of the menu and then on the Save
command. In the File Name field, the name given to the file when it was originally opened appears. To
confirm that name click on the <Ok> button. To assign a new name to the file, type the new name in
this field.
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select Save from the File menu by using the key combination ALT,F,S. To confirm the name given to the
file when it was opened press ENTER. To assign a new name, type the name in the File Name field and press
ENTER.
The program will save the file in the current disk unit and directory unless specified otherwise. To save the file
on a different disk unit or in a different directory, type the full path in the File Name field. For example, to save
the document in the root of disk C: type c:\filename or select a different unit or directory.

Printer Setup Command (ALT,F,P)
By selecting this command one goes to “Print” dialog box. Here one can verify and modify the Default printer’s
Setup or select another printer from those installed one ones system.
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Edit Menu (ALT,E)
Through this menu one can enter the data necessary for a calculation.

Section Command (ALT,E,S)
This enables one to define the geometry of the section under analysis.

The “Edit section” dialogue box
In the “Edit section” dialogue window the X,Y coordinates have to be entered (expressed in metres in respect to
an arbitrary origin) that describe the section of the channel or tube.
In the case of terraced sections it is possible that the curve represents the flow as a function of the height of the
water surface present in the sections and, in correspondence of the terraces shows a decreasing flow.
Those parts of the curve represent a meta-stable conditions: the real behaviour is represented exclusively by
increasing curve segments, and it is possible that in the situations described there are two water levels that are
physically acceptable for the same flow.
Those values will crop up presumably through this rule, tied to the way the graph is followed: the minimum water
level will exist when flow increases, conversely the maximum water level will exist with diminished flows.
This is due to the abrupt variation of the flow speed tied to the sudden increase or decrease of the wetted
perimeter coupled to a small variation of the section.
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Parameters Command (ALT,E,P)
Through this command the hydraulic parameters necessary to the program, to determine the hydraulic section
to be calculated, is defined.

The “Hydraulic parameters” dialogue box
In the “Hydraulic parameters” dialogue window the following data should be entered.

→ Gamma: it is the value of resistance per unit of surface of the wall. The value can be deduced by the nature
of the wall according to the table that follows here.
Class

Nature of the walls

Resistance

1

Channels with cement walls: cement, smoothed with great care and maintained
smooth of not too large size. Wooden walls: planed planks without clefts, arranged
with the larger size pointing in the flow direction, good workmanship. Metal walls or
walls with metal sheeting: smoothed surface without rust, flush riveting, no ridges at
the joints

0.06

2

Channels with walls in cement or wood: as in the preceding class but curved, not
0.10
very wide even when well made, water not quite limpid. New solid drawn steel tubes:
new

3

Channels with cement walls: plastering well done but not quite smooth, slight
protuberances in the joints. Wooden walls: planed planks slight unevenness at the
joints. Metal walls or walls with metal sheeting: normal riveting, no ridges at the
joints. Brick walls: regular wall made of bricks or squared stones. Cast iron pipes:
new, well laid. Solid drawn steel tubes: in regular service. In riveted metal sheeting:
double longitudinal riveting, conical joints.

4

Cement tubes: well smoothed in good conditions, with a diameter larger than 0.40 m, 0.18
clear water, conduits in riveted metal sheeting, with triple riveting, double and
transversal.

5

Cement tubes: with well smoothed plastering but with tight curves, water not limpid,
diameter smaller than 0.40 m. Cast iron pipes: under normal use.

0.23

6

Channels with cement walls: walls not well smoothed. Wooden walls: raw planks
badly cut with open joints between the planks. Earth channels: very regular
construction and excellent brick walls accurately constructed. Cast iron pipes: after
many years of service with encrustations and welts.

0.36

7

Channels with cement walls: with surface only superficially plastered with
unevenness at the joints, turbid water with deposits, moss vegetation, tortuous
channel. Stone walls: with rock material that has not been squared.

0.46

7 bis

Large channels: originally unfinished cement or being such after long use.

0.58

8

Large channels: with partially deteriorated covering or covered by deposits. Earth
channels: with highly irregular section, possibly covered by gravel. Slight deposits
that increase the roughness of the banks, absence of vegetation and rather wide
curves. Irregular brick walls, rather smooth bottom with silt deposits.

0.85

0.16

16 - SID for Windows – User Guide

9

Channels with metal walls with metal sheeting: normal riveting and ridges at joints.
Earth channels: Rather accurate constructions, slight deposits at the bottom and
smooth embankments or without deposits but with low grasses on the banks. Stone
walls: old walls in bad conditions.

1.00

10

Earth channels: regular section, low grasses at the bottom, some bushes on the
bank; limited development of vegetation through periodical removal of growths.
Natural water courses: with a rather regular course, without vegetation nor
appreciable bottom deposits.

1.30

11

Earth channels: under conditions of bad maintenance, tangles of vegetation on the
banks and bottom, or irregular deposits of blocks and gravels, also earth channels,
dug by excavators, with negligent maintenance.

1.75

12

Channels: dug into the terrain and abandoned, with uneven embankments, or with
most of the channel section obstructed by vegetation. Natural courses: with gravel
bed and movement of material at the bottom.

2.30

→ Slope angle: slope angle of channel expressed as a percentage.
→ Projected flow: it is the flow designed to pass in the channel under examination.

Titles Command (ALT,E,T)
To facilitate the reading of the drawings produced by the program a main title and five sub-titles are provided.

Gamma Command (ALT,E,G)
When one selects this command the program shows the following table used to determine the gamma
coefficient.
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To visualise the class description and the associated gamma value it is sufficient to click on the circle next to the
class. By clicking on the <Apply> button the program will show the Gamma coefficient also in the Gamma field
of the “Hydraulic parameters” window. To close the window click on the <Exit> button.
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Print Menu (ALT,P)
With this menu it is possible to produce graphic output or listings of all data by selecting from the following menu
titles: Graphics and Listings.

Graphics Command (ALT,P,G)
This enables one to visualise and print the graphical output with the results obtained. The program draws the
section on which, when defined, the fluid level corresponding to the projected flow is shown. In the “Flow”
drawing the diagram of the curve is drawn that shows the relation between flow and height, as well as an
indication of the height reached by the projected flow.

Listings Command (ALT,P,L)
By selecting this command the program opens a sub-menu where one can select the preview mode, and wether
to print or export the listing.

Listings Preview Command (ALT,P,L,P)
With this command it is possible to preview the listings pertaining to the calculation result. The listing can not be
changed here.
To scroll the text use the scroll bars on the window or use the UP and DOWN arrow keys, or the PAGE UP e PAGE
DOWN. keys. To exit press ESC or double-click any point of the listing.
The file containing the listing is saved on disc in the same directory where the data files resides. It has the same
name with the difference of the ".TAB" extension. The file is in the normal ASCII format and its pagination is
such that all commands have the # sign as prefix.

Fast Print Listings Command (ALT,P,L,F)
With this command the listings pertaining to the calculation result are printed directly.

Export Listings in DOC Format (ALT,P,L,E)
With this command the listings pertaining to the calculation result are exported in the format used by Microsoft
Word 97.
The file will have the same name but with the ".DOC" extension and will be saved in the same directory where
the data files reside.
At the end of the file exportation this file will be visualised by invoking the Winword program.

Export Listings in TXT format (ALT,P,L,T)
With this command the listings pertaining to the calculation result are exported in the “Text only” format.
The file will have the same name but with the ".TXT extension and will be saved in the same directory where the
data files reside.
At the end of the file exportation this file will be visualised by invoking the Notepad program.

Listing Export to SLK (ALT,P,L,S)
With this command, it is possible to export the listings of the calculation results into the SLK format (Microsoft
Excel 97 compatible).
The program creates a file, with the same name as the current project but with the ".SLK" extension; the file is
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saved in the same directory as the data files.
The file is automatically opened if the program finds the Microsoft Excel executable.

Configure Command (ALT,P,C)
With this command, one can define the graphical properties of the different objects in the graphical output.

One can associate a colour, a line thickness and a character font to each object. Notice that not all the objects
have both a line thickness and a character font: for example, a title only requires the colour and the character
font to be defined.
•

Click an object to select it (use the scroll bar to see the entire list)

•

Click one of the option buttons, in the “colours” frame, to select the colour that has to be associated to the
selected object. The Not drawn option hides the object of the graphical output.

•

If the object contains texts, one can choose a character font from the list (use the scroll bar to see the entire
list)

•

If the object contains lines, one can assign a thickness to the lines (in mm). If the value is zero, the program
uses the thinnest line on the output device.

•

It is possible, as an option, to assign a left and a top margin (in cm) to the whole graphical output.

NOTE: although the available set is limited to fifteen colours, they can be manually customised; double-click the
coloured bar to open the Colour Dialogue Box and choose a different RGB value associated to the selected
colour.
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Exit Menu (ALT,X)
This command allows one to exit the program. If the file being used contains modifications that have not yet
been saved the program will propose the file saving window, if you would like to save these modifications.
To save a file:


click on the <OK> button. It is possible to assign a new name to the file by typing the new name in the
File Name field before clicking the <OK> button.

Press ENTER. To assign a new name to the file type the new name in the File Name field and then
press ENTER.
To abandon the modifications:




click on the <Cancel> button: the file will abandoned and the modifications will be lost.



press ESC to select the <Cancel> button, this closes the file without saving.
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Chapter 8 - A first example
A first example
In this chapter we present a simple and easily worked example. We suggest one to follow this example to
familiarise oneself with the program.
Remember that the only parts to be typed are those appearing in bold print while single keys are identified by
SMALL CAPITAL characters.
1. Start the program by double-clicking on the SID icon. To close the message window click on the <Ok>
button or press ENTER or the SPACE BAR.
2. One is now inside the program. Click on the File menu hence click on the Open command.
3. Enter test in the File Name field and click on the <Ok> button to confirm.
4. Now one can start to enter the data. Click on the Edit menu and select Section by clicking on it.
5. Enter the points that describe the geometry of the section. Remember to press the TAB key to confirm and
pass on the next field:
0

ENTER

5

ENTER

10 ENTER
0

ENTER

15 ENTER
0

ENTER

18 ENTER
5

ENTER

To confirm click on the <Ok> button.
6. Open the Edit menu and select the Parameters command. Enter 0.16 into the Gamma field and press the
TAB key to pass to the next field, 3 for the slope and 1000 as the projected flow. Remember to press the TAB
key to confirm and to pass on the next field, hence click the <Ok> button.
7. Now select the Gamma command. The program shows a list of the classes and the relative Gamma
coefficient. To visualise the description of the class and the associated gamma value click in the circle at the
side of each class. Click on the <Apply> button and the program will copy the gamma coefficient into the
corresponding Gamma field in the window pertaining to the hydraulic parameters. To confirm click on the
<Ok> button.
8. Before performing the calculation on the entered data, open the Edit menu and select the Titles command.
Through this command one can enter titles. Remember to press the tab key to confirm and to pass on the
next field. As one can see when title length exceeds the field length the title is scrolled. It is possible to
modify or correct the title by using the left and right arrow keys. To confirm click on the <Ok> button.
9. Thus we have finished entering data and can pass on to the calculation. Open the Print menu by clicking on
it. One can choose from the following options:
- Graphics: it is the most import graphic output where the drawings of the section and the diagram of the
Q(h) curve is shown.
- Listings: under thus command one finds the sub-menus that allow one to visualise, print and export the
result listings.
- Configure: permits the definition of the colour configurations, the size and set of characters to be used in
the printing of graphics.
10. Select the Graphics command. After the execution of the calculations, the duration of which is dependent on
the type of computer used, the drawing that shows the calculated results is drawn. With the instrument bar
one can carry out the following operations:
- Zoom +: enlarges a part of a page. Note: if one does not have a character font suited for the visualisation
of the selected dimension, the program will substitute it with another.
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- Zoom -: returns the drawing to the original dimension.
- Arrows: clicking on the arrow icons after having activated "Zoom +" one can pan the drawing visible on
screen.
- Print: clicking on this third icon, or pressing the letter p key, will send the drawing to the default printer.
When the printing has finished the program returns to menu.
- Resized print: by clicking on the command the drawing is printed on the default printer resized in such a
way as to be drawn on a single page.
- DXF: clicking on this command gives access to a dialogue box that enables one to assign a different name
to the DXF file, which has by default, the same name as the data file.
- Exit: closes the window and returns to the program.
11. To terminate the work session select the Exit menu. If the file being used contains modifications that have
not yet been saved the program will propose the “Save as” dialogue box. To save the file click on the <Ok>
button.
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Chapter 9 - Value of the friction
coefficient
Value of the friction coefficient
Value of the coefficient

χ = 87

R
( R + γ)

Value of χ by γ equal to:

R
m

0.06

0.10

0.16

0.18

0.23

0.36

0.46

0.85

1.00

1.30

1.75

2.30

0.10

73.1

66.1

57.8

55.5

50.4

40.7

35.5

23.6

20.9

17.0

13.5

10.5

0.15

75.3

69.1

61.6

59.5

54.6

45.1

39.9

27.2

24.3

19.7

15.9

12.6

0.20

76.7

71.1

64.0

62.1

57.5

48.2

43.1

30.0

26.9

22.3

17.9

14.2

0.25

77.7

72.5

65.9

64.0

59.6

50.6

45.3

32.2

29.0

24.2

19.5

15.5

0.30

78.4

73.6

67.3

65.5

61.2

52.5

47.3

34.1

30.8

25.8

20.9

16.7

0.35

79.1

74.4

68.5

66.6

62.5

54.1

48.9

35.7

32.4

27.2

22.2

17.8

0.40

79.4

75.1

69.4

67.7

63.8

5.4

50.4

37.1

33.7

28.5

23.3

18.7

0.45

79.8

75.7

70.2

68.5

64.8

56.6

51.6

38.4

34.9

29.6

24.3

19.7

0.50

80.2

76.2

71.0

69.4

65.6

57.6

52.7

39.5

36.0

30.6

25.2

20.5

0.60

80.7

77.1

72.1

70.6

67.0

59.4

54.6

41.5

38.0

32.5

26.9

21.9

0.70

81.2

77.8

73.0

71.6

68.2

60.8

56.1

43.2

39.6

34.0

28.4

23.2

0.80

81.5

78.2

73.8

72.5

69.1

62.0

57.5

44.6

41.1

35.3

29.6

24.3

0.90

81.8

78.7

74.4

73.1

70.0

63.1

58.6

45.9

42.4

36.7

30.8

25.4

1.00

82.1

79.1

75.0

73.7

70.7

64.0

59.6

47.0

43.5

37.8

31.9

26.4

1.10

82.3

79.5

75.5

74.3

71.4

64.8

60.5

48.1

44.5

38.8

32.8

27.2

1.20

82.5

79.7

75.9

74.7

71.9

65.5

61.3

49.0

45.5

39.8

33.7

28.1

1.30

82.7

80.0

76.3

75.1

72.4

66.1

62.0

49.8

46.3

40.6

34.6

28.8

1.40

82.9

80.2

76.7

75.5

72.9

66.7

62.6

50.6

47.1

41.5

35.5

29.5

1.60

83.1

80.6

77.2

76.2

73.7

67.7

63.8

52.0

48.6

42.9

36.7

30.9

1.80

83.3

81.0

77.7

76.8

74.4

68.6

64.8

53.3

49.9

44.2

38.0

32.1

2.00

83.5

81.2

78.2

77.1

74.9

69.3

65.7

54.3

51.0

45.3

39.1

33.1

2.50

83.8

81.8

79.0

78.1

76.0

70.8

67.4

56.6

53.3

47.7

41.5

35.4

3.00

84.1

82.2

79.6

78.8

76.9

72.0

68.7

58.4

55.2

49.7

43.5

37.4

4.00

84.5

82.9

80.6

79.8

78.0

73.7

70.7

61.2

58.0

52.7

46.6

40.5

5.00

84.7

83.3

81.2

80.5

79.0

74.9

72.2

63.0

60.1

55.0

49.0

42.9

6.00

84.9

83.6

81.7

81.0

79.5

75.9

73.2

64.6

61.9

56.9

51.0

45.1

